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1.0 Full Motion Video 

The ArcGIS Full Motion Video (FMV) add-in and Geoprocessing tools give users the ability to view 

and analyze video data from within the ArcGIS environment. Video and metadata captured from 

drones, manned aircraft, or other platforms can be easily integrated and analyzed with 

traditional GIS datasets.  

In addition to this manual, the Full Motion Video online course is available from esri.com. It can 

be download at Working with Full Motion Video in ArcGIS. This course is free for users current 

on their software subscription; otherwise, there is an associated fee. 

The Esri FMV home page can accessed at www.esri.com/fmv. The home page includes product 

ordering and registration instructions and many additional resources.   

This User’s Manual is applicable to FMV 1.4 on ArcMap version 10.6 only.  For ArcMap 10.5, 10.4, 

or 10.3, the prior version FMV 1.3.2 is functionally equivalent to FMV 1.4. 

 

2.0 System Requirements 

2.1 System Requirements 

The system requirements for Full Motion Video are the same as the version of ArcMap. 

• ArcGIS 10.6 Desktop System Requirements 

•  Licensing and Software Requirements 

• ArcMap 10.6 must be installed. 

• The FMV add-in and geoprocessing tools will work with a Basic, Standard, or Advanced 

license. 

• Mosaicking requires a Standard or Advanced license.  

• The ArcGIS Full Motion Video Add-In is now available here. 

• Your video stream and files must have metadata that is Motion Industry Standards Board 

compliant. It is highly recommended that you review the latest MISB description which 

can be downloaded by going to http://www.gwg.nga.mil/misb/zip_pubs.html and 

downloading the latest Composite Documents Zip File > Opening ST0601.9.pdf. 

• You must have installed an extraction utility, such as 7-Zip. You can download 7-Zip for 

free at http://www.7-zip.org/ 

https://www.esri.com/training/catalog/5806637ec82bd5746b9143dd/working-with-full-motion-video-in-arcgis/
http://www.esri.com/fmv
http://desktop.arcgis.com/en/system-requirements/latest/arcgis-desktop-system-requirements.htm
http://desktop.arcgis.com/en/system-requirements/latest/arcgis-desktop-system-requirements.htm
http://www.esri.com/products/arcgis-capabilities/imagery/full-motion-video
http://www.gwg.nga.mil/misb/zip_pubs.html
http://www.7-zip.org/
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3.0 Release Notes 

3.1 New Features  

NOTE:  This list is for FMV 1.3.2; FMV 1.4 has been updated for ArcMap 10.6 only 

• Full support for ArcMap 10.6. 

• Increased performance with support for 2.7K, 4K, and higher resolutions (performance 

may depend on CPU/GPU)  

• A new video search workflow and updated UI make searching for archived videos faster 

and more intuitive.  

• A new digitizing workflow, which automatically creates new fields and data when 

digitizing features directly on a video: Video_Date (Esri date type), Video_Time (MISB 

Precision Time), and Video_Source).  

• Video imagery captured with the FMV geoprocessing tools now contains key video 

metadata, such as video path, elapsed time, time stamp, and more. Metadata is available 

in external CSV’s or embedded as EXIF file headers.  

• The Capture Groups of Images tool in the FMV Add-in allows users to record videos as 

individual frames while streaming live. Images are recorded along with their metadata 

and can be easily turned into a mosaic dataset using the Mosaic Video Frames GP tool. 

• The Capture Groups of Images tool in the FMV Add-in allows users to record videos as 

individual frames while streaming live. Images are recorded along with their metadata 

and can be easily turned into a mosaic dataset using the Mosaic Video Frames GP tool. 

• The Mosaic Video GP tool now supports JPG, JP2, PNG, NITF, and TIFF file types. All 

transforms are now explicitly Projective transformations (a formula used to transform 

data captured directly from aerial photography), which increases overall accuracy without 

changing any of the original pixel data.  

• The addition of a new GP Tool called Extract Video Frames for Orthomosaic. This tool can 

be used to extract individual video frames and associated MISB metadata from a video. 

The extracted video frames and their associated metadata may then be input to other 

Esri tools or applications, such as the Ortho Mapping Tools for ArcGIS or the Esri 

Drone2Map application. There, the video frames can be processed to generate an 

orthorectified mosaic image and other derived products. 

• Bug fixes and performance improvements. 
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3.2 Tips and Best Practices 

• Recording, mosaicking, time-syncing, and displaying map features on the video are all 

computationally intensive operations. 

• Please keep this in mind when running these operations on multiple videos at the same 

time or when using other computationally intensive ArcMap tasks. 

• Positional accuracy of digitized features declines with increasingly oblique angles of video. 

For best accuracy, digitize over video collected at near nadir or vertical angles (e.g. from 

as directly above as possible). 

• High video frame-to-metadata ratios will typically result in smoother map geometry and 

more accuracy when running full motion video functions, such as digitizing or measuring. 

• To digitize features on a video, start an edit session and use a feature template. 

• Output from the Extract Video Frames for Orthomosaic GP tool is meant to be further 

processed in orthorectification workflows, not standard ArcMap mosaicking of 

georeferenced imagery. 

 

3.3 Known Issues 

• The FMV Geoprocessing tools are not automatically installed when upgrading to a new 

version of ArcMap.  If you are installing a new version of ArcMap, you must uninstall FMV 

first.  Refer below to section 3.5 which describes removal of the FMV add-in and GP tools.  

• Bookmarks may need to be clicked more than once in order to zoom to their locations. 

Each additional time a bookmark is clicked a larger search is run for the closest metadata 

packet to the requested frame. This is required because metadata packets may either be 

in front or behind the requested frame. 

• On some systems, a video player window may resize very slowly, in small increments. To 

prevent this, activate the Manually resize player windows option from the Video 

Manager. This option is off by default. 

• When playing videos with minimal metadata and using the 'Display features from the map 

on the video' tool features may appear 'choppy'. To prevent this, enable the Check to 

maintain smooth playback option under the General tab of the video properties. This will 

animate the features using a built-in timer for a smoother display. 

• When capturing an image while a video is playing, some image file types may take slightly 

longer to save to disk such as tif and jp2 
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• When capturing an image while the video is playing, the video may pause slightly as the 

image is saved to disk, depending on image file type 

• When capturing groups of images, the video may pause slightly as the image is saved to 

disk, depending on the image file type. This may occur at the image capture interval 

specified in the video Properties dialog. 

• Specifying National Imagery Transmission Format Standard (NITF) output when using the 

Mosaic Video Frames GP Tool may result in dropped frames. In this case specify any of 

the other image formats as output (i.e., tif, png, jpg, jp2) 

3.4 Installing the FMV Add-In 

There are two scenarios for installation of the FMV Add-In. If you are updating from a previous 

version of FMV, you MUST uninstall it first.  Refer to section 3.5 below. 

For a new installation, proceed here:  

1. In the Windows file manager, navigate to the location where you downloaded the zip 

file package containing the Add-In. 

2. Unzip the package. 

3. Double-click the Add-In file, named 

"ESRI.ArcGIS.Video.FullMotionVideoAddin.esriAddIn". 

4. Click the Install Add-In button to confirm the file installation of the ArcGIS Full Motion 

Video Add-In 1.4. The utility copies the Add-In file to your default ArcGIS Add-In folder. 

5. Click OK. 

6. Open ArcMap. 

7. Click the Customize menu in ArcMap and click Extensions. The Full Motion Video check 

box should be selected. If it isn't, close and restart ArcMap to ensure that the add-in 

is recognized. 
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8. Click Close. 

The Add-In is now ready to use, but you will also want to install the Geoprocessing Tools.  Refer 

below to section 3.8. 

3.5 Updating a Previous Version of FMV 

Remove a previous version of “ArcGIS 10.x Full Motion Video Geoprocessing Tools” using 

Windows Control Panel.  Note that you MUST perform this uninstall BEFORE upgrading ArcGIS 

for Desktop to 10.6. 

1. Open Control Panel. 

2. Click on Programs and Features 

3. Click on “ArcGIS 10.x Full Motion Video Tools” where x is the version currently on your 

system. 

Remove a previous version of FMV from the Add-In Manager: 

4. Open ArcMap. 

5. Click Customize > Add-In Manager 

6. Under My Add-ins select the previous version of Full Motion Video that needs to be 

removed. 

7. Select Delete this Add-in. 

The Geoprocessing tools, if installed, must also be removed.  Note that you MUST perform this 

uninstall BEFORE upgrading ArcGIS for Desktop to 10.6.  This is accomplished using Windows 

functionality for “Add/Remove Programs” – Look for the Full Motion Video Geoprocessing Tools 

and run the Windows uninstall before proceeding with a new installation.  

 

Once uninstallation is complete, continue below.  

8. From the Add-In Manager, click Customize. 

9. On the Customize dialog box click Add From File 
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10. Browse to the "ESRI.ArcGIS.Video.FullMotionVideoAddIn.esriAddIn" Add-In file, click 

the file to select it, and click Open. 

11. Click the Install Add-In button to confirm the file installation. The utility copies the 

Add-In file to your default ArcGIS Add-In folder. A list of the added objects is displayed. 

12. Click OK. 

13. If the “ArcGIS 10.x Full Motion Video Geoprocessing Tools” for a previous version was 

installed, this MUST be uninstalled before upgrading ArcGIS for Desktop to 10.6 by 

using Windows Control Panel to uninstall 

14. On the Toolbars tab of the Customize dialog box check the ArcGIS Full Motion Video 

toolbar. 

15. Click Close. 

The ArcGIS Full Motion Video toolbar will appear.  

 

16. Click the Customize menu in ArcMap and click Extensions. 

17. ArcGIS Full Motion Video should now be listed and checked on. If it is not, close and 

restart ArcMap. 

18. Click Close. 

19. Full Motion Video will now be listed under Add-Ins in the Add-In Manager. 

20. Click Close. 

The Add-In is now ready to use, but you will also want to install the Geoprocessing Tools.  Refer 

below to section 3.8. 

3.6 Add Video File Types Into ArcCatalog 

The ArcGIS Full Motion Video 1.4 Add-In is now ready for use. The first step is to add the 

recognized video file formats. 

1. Open ArcCatalog. 

2. To see what video file types are currently supported open the Customize menu and click 

ArcCatalog Options. 

3. Navigate to the File Type tab. 
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The File Types tab lists supported file types and allows the user to specify new file types that will 

be shown in Catalog. 

4. Click the New Type button. 

5. In the File Type dialog box type the file extension, as well as a description of the file type. 

 
Note: in this example an MPEG-2 Transport Stream, which has a '.ts' file extension, is 

being added. 

 

 

6. Click OK. 

The file type is added and will now be visible in ArcCatalog. 

 

7. Click the Apply button. 
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8. Add any other video file types that need to be displayed in ArcMap using steps 4 - 7. 

The following is a comprehensive list of the supported file types: 

Description Extension 

H.264 Video File H264 

MPEG File MPG  

MPEG File MPEG  

MPEG-2 File MP2 

MPEG-2 File MPG2 

MPEG-2 File MPEG2 

MPEG-4 File MP4 

MPEG-4 File MPG4 

MPEG-4 File MPEG4 

MPEG-2 Program Stream PS  

MPEG-2 Transport Stream TS  

ESD File VOB 

9. Click OK to close the ArcCatalog Options dialog box. 

 

3.7 Add The Full Motion Video Toolbar to ArcMap 

The ArcGIS Full Motion Video 1.4 Add-In provides a toolbar for working with video files in ArcMap.  

To add the toolbar to ArcMap: 

1. In ArcMap, click Customize, point to Toolbars, and click ArcGIS Full Motion Video to 

show the toolbar. 

 

3.8 Installing the FMV Geoprocessing Tools 

The geoprocessing tools that come with the Full Motion Video Add-In are designed to extend the 

utility of the FMV functionality. These tools do things like extract metadata, create video search 

indexes, turn videos into mosaic datasets, and more. These tools can be used independently, in 

python scripts, or in geoprocessing models.  
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Installing the FMV geoprocessing tools: 

2. Navigate to the software subfolder where FMV was installed. Here you will see a 

folder containing the geoprocessing tools specific to the version of ArcGIS that you 

requested. 

3. Double click setup.exe to start the installation, and follow the steps on the wizard. 

4. The installation package now creates a toolbox on the user's behalf. The toolbox is 

located in ArcCatalog under Toolboxes > System Toolboxes > Full Motion Video 

Tools.tbx. The toolbox is installed to the user's install directory. 

5. For example, C:\program files (x86)\arcgis\desktop10.3\ArcToolbox\Toolboxes\Full 

Motion Video Tools.tbx. 

6. After installation, click on the Customize tab and select Extension to ensure the Full 

Motion Video extension is added and checked on.  

7. If the Full Motion Video extension is not visible in the list of available extensions, exit 

ArcMap and restart the ArcMap application. Click on the Customize tab and select 

Extension to ensure the Full Motion Video extension is added and checked on.  

 

Note:  The multiplexing field mapping and time shift templates are available after the 

Geoprocessing tools are installed. Go to your install directory and look for a folder called 

Video Multiplexer Templates. A typical location is C:\Program Files (x86)\ArcGIS 10.6 Full 

Motion Video Geoprocessing Tools\VideoMultiplexerTemplates. The files are titled: 

Video_Multiplexer_MISB_Field_Mapping_Template.csv  

and Video_Multiplexer_TimeShift_Template.csv.  
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4.0 Using the ArcGIS Full Motion Video 1.4 Add-In 

4.1 Overview 

The FMV Add-In is comprised of 3 main functional components, the Video Manager, Video Player 

and Geoprocessing tools designed to extend the utility of the FMV application to accommodate 

common real-world operational scenarios. These functional components are integrated to work 

together, and result in a robust Full Motion Video experience. Each of these components are 

addressed in turn according to a generic workflow.  

4.2 Play an Archived Video File 

To play an archived video file, you need to know its location. 

1. From the toolbar click the Add An Archived Video File button. 

 

2. Navigate to the video file, highlight it, and click Add. 

The ArcGIS Full Motion Video Player opens. 

 

3. You may also load a video by dragging the video file from the Catalog and dropping it 

into the video manager 

The ArcGIS Full Motion Video Player opens.  
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The video player may be resized while a video is in the Play or Pause state by dragging a corner 

of the player window to the desired size. The player may adjust horizontally or vertically to 

maintain the aspect ratio of the video size format. 

The lower part of the ArcGIS Full Motion Video Player has buttons to control the playback of the 

video. These DVR controls are described below. 

4.3 Control Playing of the Video in the Video Player 

• Play / Pause      

o Behavior – When clicked, the control flips to Pause (when playing) or Play (when 

paused) depending on state 

o The video plays according to the frame per second rate of the video 

o Pause stops the video 

▪ Behavior - displays the video frame at full resolution for the selected zoom 

level and video player format size. 

o Play – Plays the video 

▪ Behavior - at the selected zoom level and position within the video frame 

• Fast forward 

o Fast Forward is speed indicated on “Playback Rate” of the Video Player 

▪ Whole number increments each time fast forward is clicked. 
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▪ Playback speed is reset to 1x when the player is paused or stopped 

• Fast rewind  

o Rewind speed is indicated on “Playback Rate” of the Video Player 

▪ Whole number increments each time rewind is clicked. 

▪ Playback speed is reset to 1x when the player is paused or stopped 

• Step forward 

o Step Forward by whole number of seconds increment  

• Step backward  

o Step Backwards by whole number of seconds increment 

▪ Behavior - Both forward and backward stepping (which can be different) is 

set in the video’s Properties  

• Video playback slider handle 

 

The video playback slider handle indicates the relative location within the video timeline 

being displayed in the Video Player. 

o The location within the video is indicated in both the UTC Timestamp on the lower 

left of the DVR controls, and the time stamp of video frame within the video file 

(upper left of the DVR controls). 

o The video playback slider handle can be grabbed with a left click and moved along 

the playback slider timeline 

o The speed of the video is displayed in the video player corresponding to the 

position of the video playback slider position 

• Playback Rate Display (fast forward and rewind for video review) 

 

o As described in Fast Forward/Backward above, the playback rate reflects whole 

numbers when Fast Forward or Fast Rewind buttons are clicked 

o Click on the Pause button to stop the video. The playback rate is reset to 1X  
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• Adjust Play Rate 

To play the video at a rate less or more than normal playback, use the slow-motion control 

at the bottom of the video player. The slow-motion control allows fine-grained control 

over playback speed. The range of values extends from 0.00x to 3x play speed. The tick in 

the middle of the control is 1x speed, or normal playback speed. 

 

o The Playback rate is fractional number based on slider position 

o Resolution is .01 sec 

 

Some key points about slow motion control: 

o Values below 1x can be changed in increments of 0.01 by using the left and right 

arrows on the keyboard. 

o 0.00x is the equivalent of pause. 

o Double click the slow-motion slider to automatically return to a playback speed of 

1x. 

o The slow-motion playback rate is reset to 1x whenever any of the time slider or 

standard DVR controls are used. 

o The slow-motion control can be used with live streams by clicking the Review the 

previous 30 seconds of live stream button. If you are watching a live stream, but 

not reviewing the previous thirty seconds then the slow-motion control will have 

no impact. 

 

• Clipping an archived video 

Steps: 

1. Grab the handle that is at the beginning of the time slider and move it to the point in 

the video when you want to begin the export. 

2. Grab the handle at the end of the time slider and position it at the end of the clip. 
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o See the video playback during manual adjustment of each handle 

o The left timestamp indicates the position within the video of the beginning or end 

clip handle on the slider. 

3. Click the Export Clip button on the Full Motion Video Player. 

o Additionally, you can right-click on one of the handles or use the Ctrl + E shortcut 

to export. A file navigation dialog will open for you to specify the directory and 

filename. 

o Choose any of 12 supported video file types  

 

The portion of the video between the two handles will be saved. The naming convention is the 

name of the original video_start clip time_end clip time. For example, if a video called 

MyVideo.mpg is 10 minutes long and the clip starts at three minutes forty-seven seconds 

(00:03:47) and ends at 00:07:42 then the name of the clip will be MyVideo_00-03-47_00-07-

42.mpg. 

 
Note:  To return the handles to their original position, double click on one of the handles. 

Alternatively, you can drag both handles to the beginning and end of the original video. 

 

• Display time stamp of current video frame 

 

o The UTC UNIX timestamp in human-readable format is displayed as the video 

plays.  

o This timestamp reflects the position of the video slider along the video file 

timeline. 

•  Display of video play time 
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o Time stamp of the video position slider handle along the video file timeline 

o Left time stamp reflects the position within the video file, the right time stamp 

reflects the length of the video file.  

o Format is days, hours, minutes, seconds 

• Display coordinate of frame center 

 

o The Longitude and latitude coordinates (WGS84) of the video frame center is 

displayed as the video plays. 

 

4.4 Play A Live Video Stream 

To play a live video stream, you will need either the UDP, RTSP, or MJPG address of the video 

stream. 

 

Note:  The Full Motion Video player currently supports Internet Protocol version 4 (IPv4) 

addresses and both the User Datagram Protocol (UDP) and the Real Time Streaming 

Protocol (RTSP). MPEG TS streams can be broadcast as UDP unicast or multicast and can 

include MPEG-1, MPEG-2, and H.264 video decoding, and KLV metadata parsing. RTSP 

playback is supported for live RTSP streams that use any of the following video codecs: 

MPEG-1 Video, MPEG-2 Video, H.264, and MJPEG. 

Steps: 

1. Click the Add A Video Stream button.  

 

2. The Add Video Stream dialog box opens. 
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3. Type the address of the video stream in the dialog box. 

4. Click Open, which opens the video player and loads the live streaming video. 

 

The DVR controls on the Video Player work differently in live stream mode. Only the Play and 

Pause control works for live stream and there is no progress bar. If the video is paused, you will 

notice that the time stamp indicator continues to progress and shows the current cumulative 

time that the video has been playing. Once you toggle the Play button (from pause mode) the 

video jumps to its real-time stream state. 

The functionality of the buttons on the player are addressed in the Tools on the Video Player, 

Live Stream section below. 
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4.5 General Behavior of the Video Player 

• Zoom Video Player 

o Mouse finger wheel 

▪ When the Video Player is active and mouse enabled, roll the mouse finger 

wheel away from yourself to zoom out and towards yourself to zoom in 

▪ When zoomed, the cursor changes from the default arrow to a hand 

• Zoom Overview Window 

o Display position of the zoomed view within the video frame 

o The relative size and position of the zoomed view within the video frame is shown 

o The size and position of the zoomed view persists as the video plays   

 

• Pan 

o In zoomed view, depress left mouse button to grab and pan the zoomed view 

within the video frame. When depressed, the cursor changes from the open hand 

to the grab hand 

o Operates at different zoom levels 

o Operates while video plays or is paused 
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4.6 Tools on the Video Player 

Besides the DVR controls, important and useful FMV functionality is accessed from tools on the 

Video Player. These tools on the video player supports common video analysis and management 

operations and workflows. 

The following table describes the function of each of the buttons on the video player. 

 Create a bookmark (Ctrl + B) 

 Take a screenshot of the current frame 

 Start/Stop displaying features from the map on the video 

 Enable/Disable marking 

 Measure 

 Start/Stop querying time-aware layers 

 Clip the video 

 Export to Power Point 

The ArcGIS Full Motion Video Player displays the recording status, where it is white when not 

recording, and red when recording. 

Click the up arrow to hide the ArcGIS Full Motion Video Player buttons. Click the down arrow to 

show the buttons again. 

A description of the functionality of each button follows. 

 

Create a Bookmark  

• Click on the tool icon to collect a bookmark for a specific video frame. 

• Bookmarks are indicated by tic marks on the video player progress bar noting their 

position.  
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• Bookmarks can be collected when the video is in play, fast forward/rewind, step 

forward/backward or pause modes. 

• Bookmarks are collected in a table in the Bookmark Manager pane (see Bookmark tab 

on the Properties page below). 

• The Bookmark Manager pane is opened by right click context menu, “Manage 

Bookmarks.” 

 

Take a screenshot of the current frame   

• Click on the tool to capture a video frame image. 

• Images may be captured while the video is playing or is paused. 

• Image is stored in the directory specified in the Image Properties dialog, “Capture Single 

Image” tab (see Image Properties below). 

• Image is stored in the image file format specified in the Image Properties. 

• Metadata for the image is created and stored in an associated .aux.xml file in the same 

directory. 

• Georeferencing information is stored in an associated world file in the same directory. 

• An associated image overview file is also created and stored in the same directory. 

• The image name and associated files are named according to the convention of [video file 

name] appended by timestamp and file type extension. 

 

Start/Stop displaying features from the map on the video   

• Click on the tool to start or stop displaying feature class features on the video. 

• Features are displayed as the video is playing or paused. 

• The features are also displayed on the map. 

• The features may appear to be offset from the ground objects visible in the video if the 

video was collected at an oblique angle or if the imaging platform was a long distance 

from the object on the ground. 

• See section 4.12 Digitizing Features in the Video Player and Map for more details about 

digitizing features in the Video Player and the map. 
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Enable/Disable marking  

• Click on the tool to enable and disable the collection of points called marks, then click the 

map or video to mark corresponding points.  

• Marks may be collected on the video while it is in play, paused or fast forward/rewind 

mode. 

• Marks may be collected on the video or on the map. 

• Marks are visible on both the video and the map as they are being collected. 

• Marks have the same color as the color representing the video in the player and the video 

manager. 

• Marks may be saved as a point feature class with a right click context menu “Save Marks.” 

• Marks are removed with a right click context menu “Remove Marks.” 

 

Measure   

• Click on the tool to enable or disable measurement of object in the video player. 

• The state of the video player must be in Pause mode to make measurements. 

• The measurement units are specified in the Properties dialog. 

• Supported measurement types are lines and polylines. 

• A single click sets the first point, then move the cursor to the next point to be measured 

and click, then too the next point, etc. Measurement is completed with a double-click. 

 

Start/Stop querying time-aware layers   

• Click on the tool to enable and disable the querying of time aware layers. 

• The rate at which time aware layers are queried relative to the video’s current time are 

specified in the video’s Properties dialog. 

 

Export Video Clip   

• Click on the tool icon to export a video clip. 

• Exports the video segment between the start and end slider handles. This operation needs 

to be done first. Export then saves the clip defined by the start and end slider handles. 

When selected, a file save dialog opens allowing you to navigate to a directory and save 

the video clip in any of 12 supported video formats. 
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o Exported video clip format can be different than the source video format 

 

Export to Power Point   

• Click on the tool to automatically generate a report in PowerPoint 

• Report is generated for archived or live streaming videos 

• Generates four PowerPoint slides containing: 

o Video frame image 

o Zoomed view displayed in the player 

o Video frame footprint displayed on the ArcMap map 

o Context of Video Frame displayed on the map in ArcMap: 

▪ Platform Ground Track 

▪ Platform Heading 

▪ Sensor pointing direction 

▪ Video footprint 

o Appropriate metadata is also captured and provided in the notes section of the 

PowerPoint report, including: 

▪ Location of the source data on disk 

▪ Elapsed time of the video frame within the video segment 

▪ Unix time stamp 

▪ Frame center latitude and longitude 

▪ Coordinate system 

▪ Latitude and longitude coordinates of the four corners of the video frame 

▪ Mission or Project name 

▪ Imaging platform information 

▪ Any bookmarks collected within 30 seconds of the exported video frame 

• Opens the PowerPoint application if it is not currently open and writes the data above 

into the report 

• If PowerPoint is already open, it appends the data above into the existing presentation 
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4.7 Tools on the Video Player in Live Stream Mode 

The interface when streaming a video is different that when playing an archived video. 

 

The following table describes the functionality of each button when streaming a video. 

 Take a screenshot of the current frame 

 Start/Stop displaying features from the map on the video 

 Enable/Disable marking 

 Measure 

 Start/Stop querying time-aware layers 

 Start/Stop recording 

 Review the previous 30 seconds 

 Export the previous 30 seconds of the stream 

 Export frame to Power Point 

A description of the functionality of each button in Live Stream mode follows. Several of the tools 

exhibit the same behavior as when working with archived video data. Please refer to the 

functional description in the previous section for, “Same functional behavior as with archived 

videos.” 
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Take a screenshot of the current frame    

• Same functional behavior as with archived videos 

 

Start/Stop displaying features from the map on the video   

• Same functional behavior as with archived videos 

 

Enable/Disable marking   

• Same functional behavior as with archived videos 

 

Measure   

• Same functional behavior as with archived videos 

 

Start/Stop querying time-aware layers   

• Same functional behavior as with archived videos 

 

Start recording a Live Stream   

• Click on the tool to start / stop recording a live stream 

• Specify the directory to write the file and the video file type in the video’s Properties 

dialog, Record tab 

 

Review the previous 30 seconds   

As a live stream plays it is buffered and the last 30 seconds are constantly saved to memory. Click 

the Review previous 30 seconds button to playback and review the buffer at your own pace. 

Once in playback mode you can review the video, capture video frame images, save metadata, 

mosaic, and watch in slow motion.  

• Click on the tool to review the previous 30 seconds of the live stream which is 

continuously refreshed and stored in a buffer 
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• Since this is a video clip stored in memory and loaded into the video player, all the DVR 

controls can be used on this clip. Thus, you can rewind, fast forward, step backward and 

forward etc. in this 30 second clip 

• You can mark this 30 second clip and save the marks to a file 

• Click on the tool to resume viewing the live stream in real time 

 

Export the previous 30 seconds of the stream   

• Click on this tool to export the previous 30 seconds of the live stream 

• A dialog will pop up where you specify the directory and file name 

• The default video clip naming convention is the current date and time the recording is 

started in UNIX time. For example, November 11, 2014 at 2:34:23 pm is expressed as 

20141110T143423.mpg. 

• The video file type is specified in the video’s Properties dialog, Record tab 

 

Export frame to Power Point   

• Same functional behavior as with archived videos 

 

4.8 Video Player Context Menu 

Useful functionality is conveniently accessible from a context menu displayed with a mouse right 

button click in the Video Player. These functions affect how video and associated data is 

visualized and managed.  
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The purpose and performance of each item in the Context Menu is described in the table below. 

Icon Function Name Description 

 
Zoom 

Zoom to the map location of the video. The view within the 
map display includes the video frame as well as the ground 
track of the imaging platform. 

 
Zoom to Frame Zoom to the map location of the video’s current frame. 

 
Follow Continuously center the map display on the video as it plays. 

 

Key Frames Only 

Play the video using only the key frames. Key frames usually 
represent the best quality image within the video, but are 
intermittently distributed throughout the video. As a result, 
the video playback may appear choppy. 

 
Remove Marks Remove marks from the video and the map 

 
Save Marks 

Save marks to a point feature class geodatabase. A dialog 
opens to enable you to navigate to and select the 
geodatabase, and name the feature class file. 

 
Show Graphics 

Show all the graphics for the video on the map, including the 
platform position, frame center, frame outline and field of 
view 

 
Hide Graphics 

Hide all the graphics for the video on the map, including the 
platform position, frame center, frame outline and field of 
view 
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Icon Function Name Description 

 
Refresh Graphics 

Refresh all the graphics for the video on the map, including 
the platform position, frame center, frame outline and field 
of view 

 
Initial Player Size Fit the video player to its initial display size 

 
Fit Player to Video 

Fit the video player to the size of the video based on the size 
format of the video, i.e., the number of columns and rows of 
the video frame 

 
Manage Bookmarks 

Opens the Bookmark Manager. See the Book Manager 
section for more details about functionality of the Bookmark 
Manager 

 
Metadata 

Opens a table displaying the metadata of the video in play or 
paused mode. See more detailed description below. 

 
Properties 

Opens the properties window. See more detailed description 
in the Properties section. 

Metadata window 

When Metadata is selected from the Video Player context menu, the Metadata window is 

opened and the video’s metadata is displayed as the video is playing or in pause mode. Videos 

can be archived or live stream videos. 
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The metadata of a video may be recorded to a CSV file by clicking on the Start recording to a CSV 

file button Metadata will be recorded to the CSV as the video plays. The recording status is 

indicated as “recording” (red dot) or “not recording” (blank).  

The CSV file containing the metadata is saved in the directory specified in the window.  

The display of the metadata will become static when the Freeze the Metadata View button   

is clicked. 

The display of the video’s metadata may be cleared by clicking on the Clear the Metadata View 

button.  

4.9 Video Manager 

The Video Manager is a very important component of the overall Full Motion Video functionality. 

It facilitates the management of multiple video files, the behavior of the videos, data and 

information about videos and extracted from videos, and how this data is managed, displayed 

and analyzed. It is the “command and control center” for the Full Motion Video Add-In. 

The ArcGIS Full Motion Video Manager window lets you set properties and control the videos in 

your map. 

Steps: 

1. Click the ArcGIS Full Motion Video Manager button in the Full Motion Video Toolbar. 

 

The ArcGIS Full Motion Video Manager opens. 

 

4.9.1 Using the ArcGIS Full Motion Video Manager Menus 

Videos may be loaded into the Video Manager from the main toolbar, Add a Video Stream or 

Add an Archived Video File. You can also drag and drop videos from ArcCatalog and Windows 
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Explorer onto the Full Motion Video Manager. Multiple video can be loaded and managed in the 

Video Manager. 

Each video loaded into the Video Manager is identified by an ID, Name and type of video, either 

archived or live stream. The default name listed in the Video Manager is the name of the video 

file, but you can rename it in the manager.   

Click on the color chip for a video listed in the manager to select a unique color for the video. The 

video’s assigned color applies to the Video Player, all the graphics displayed on the map including 

the frame outline, center, sensor ground track, field of view, marks and measurements. Since 

multiple videos can be loaded, managed and playing at the same time, the color assigned to a 

video is an easy way to identify the specific video while playing, managing and analyzing a video. 

Groups of video images are captured for one or more videos by clicking on the Capture button 

 - red indicates that the state is in record mode and video frames will be captured according 

to the parameters specified in the Properties window as the video plays. 

Metadata may be recorded for one or more videos by clicking on the Metadata radial button for 

the video - red indicates that the state is in record mode. Metadata for the video is recorded to 

a feature class geodatabase according to the parameters specified in the Properties window, 

Metadata tab as the video plays. See the Properties Window section for more details. 

The directory path and video file name is displayed in the manager. 

Various functions and menus for managing video are available in the toolbar at the top of the 

Video manager window. 

 

The video management tools are described below. 

File 

The File menu allows you to add and remove archived or live streaming videos from the video 

manager. 

Edit 

The Edit menu lets you remove all marks from the map and each video. 

View 

The View menu lets you zoom to the extent of all videos, follow what the video is recording on 

the map, control graphics, enable key frames, and set the video’s refresh rate. 
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Each of these viewing video management operations are described below. 

Icon Group Name Operation Description 

 

Zoom Zoom 

Zoom to the map location of the video. The 
view within the map display includes the video 
frame as well as the ground track of the 
imaging platform. 

 
Follow  

Zoom to the map location of the video’s 
current frame. 

 
 Follow Videos 

Continuously center the map display on the 
video as it plays. 

 
 

Stop Following 
Videos 

Stop following all videos 

 
 Full Extent 

Zoom to the full extent of all currently playing 
videos 

 
 

Expanded Full 
Extent 

Zoom to the expanded full extent of all 
currently playing videos. A larger area is 
displayed in the map. 

 
 

Manually Set 
Extent 

Manually set the extent of the map view 

 
Graphics  Manage the display of Graphics 

 
 Show Graphics 

Show all the graphics for the video on the map, 
including the platform position, frame center, 
frame outline and field of view 

 
 Hide Graphics 

Hide all the graphics for the video on the map, 
including the platform position, frame center, 
frame outline and field of view 

 
 Refresh graphics 

Refresh all the graphics for the video on the 
map, including the platform position, frame 
center, frame outline and field of view 

 
 

Software 
Rendering 

Enable software rendering of graphics 
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Icon Group Name Operation Description 

 

 
Hardware 
Acceleration 

Enable hardware acceleration, if available. 
Utilizes computer hardware resources to 
increase performance of rendering and display 
of graphics 

 
 Linear Resampling 

Resampling for video playback performance, 
enable for increased performance 

 
 High Resolution 

High resolution video playback, especially for 
larger video size formats and computer display 
resources 

 
Key Frames  

Enable or disable key frame playback for all 
videos 

 
 

Enable Key Frames 
Only 

Enable key frame playback for all videos 

 
 

Disable Key Frames 
Only 

Disable key frame playback for all videos 

 
Refresh Rate  

Set the video graphic refresh rate to High, 
Medium or Low 

Bookmarks 

The Bookmarks menu provides quick access to any frames in any of the videos that you have 

bookmarked. Please refer to the Bookmark section in the Properties window for more details on 

how to manage bookmarks. 

Customize 

The Customize menu lets you add an elevation model to enhance positional accuracy; this is 

addressed in more detail in the Properties section below. Additionally, you can resize the video 

player, set the properties for exporting to Power Point, and you can reset the time extent for 

ArcMap to its default. From this menu, you can set the units of measurement to metric or 

imperial. 
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 Note:  The options on the Edit, View, and Customize menus apply to all videos. 

 

 

Note:  Set the following options to increase performance. 

• Stop following videos. View > Follow > Stop Following Videos    

• Hide graphics. View > Graphics > Hide Graphics. This hides video frame 

footprints, ground track and other graphical information associated with the 

video 

• Try both Software rendering and Hardware acceleration to see which works best 

for your system. View > Graphics > Software rendering/Hardware acceleration 

• Use linear resampling. View > Graphics > Linear resampling 

• Use key frames only View > Key frames > Enable key frames 

 

4.10 Video Search 

Video Search is a very powerful capability of the FMV Add-In which enables large collections of 

video files to be searched and pertinent segments identified according to geographic location, a 

particular feature and/or time. The result of a video search is a sortable list of video files, queued 

to the exact segment within the video file containing your search criteria, for example the 

geographical extent of your search. These video segments can be exported as separate video files 

complete with associated with MISB-compliant metadata.  

A prerequisite for searching through collections of video files is that the metadata containing the 

relevant information for each video file, and portion of a video stream, be extracted from the 

MISB-compliant video stream. Often this is done ahead of time using the Extract Metadata GP 

tool which creates feature class layers containing video frame centers, outline and the sensor 

platform. The search tool combs through this data to extract the portion of each video file that 

meets the criteria.  

Extracting the metadata can also be performed right from the video search tool which creates a 

GP model to extract the metadata from one or more video files. The entire video search 

workflow, including creating video search indexes, is described in this section. 
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4.10.1 Utilizing the Video Search Tool 

The Video Search tool is comprised of three main functional areas: 

1. Creating and utilizing search indexes 

2. Loading the Search Indexes and conducting the search, and, 

3. Refining the search criteria based on geographic location, and/or selected features 

and/or time range. 

Each of these functional areas are described below. 

 

4.10.1.1 Create and Utilize Search Indexes 

The first section of the Video Search window addresses the creation and/or utilization of video 

file search indexes. 

Please note that video search indexes created with the FMV ‘Extract Metadata from Video’ GP 

tool must be the same absolute length of time as the video they are derived from. Search indexes 

cannot be created from videos comprised of clipped portions of a parent video. 
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Steps: 

1. Click the toolbox icon  to save a toolbox containing a geoprocessing model 

designed to create a search index based on multiple video files, and a geoprocessing 

tool to index a single video file.  

2. Expand the toolbox you created to display the Extract Metadata from Multiple Videos 

model. Right-click the model and select Edit. The model opens in another window.  

The geoprocessing model should look like the adjacent graphic. It recursively extracts the 

metadata from multiple video files and creates the feature class data used in the search.  

The model is simple and fast to set up and use in two easy steps. 

 

3. In the Catalog window, click the directory containing the video files to be searched 

and drag/drop it into the oval Location of Videos parameter in the model.  
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The appropriate model parameters are activated and colored. 

4. Next, in the Catalog window, click the file geodatabase to contain the metadata and 

drag/drop it into the Output Workspace parameter oval in the model. 

 

The appropriate model parameters are activated and colored. 

5. You can speed up the extraction by double-clicking the Video Playback parameter on 

the model and changing the Video Playback Rate default value of 20 to 60 or 70. This 

will greatly increase the extraction rate and rip through videos much faster. 

 



Using the ArcGIS Full Motion Video 1.4 Add-In 

 

Copyright © 1995-2018 Esri. All rights reserved. 35 

6. Execute the model by clicking the Run  button on the main toolbar of the model 

window. It may take some time to extract the metadata from multiple lengthy video 

files. The metadata is extracted and saved as 3 separate feature class datasets in the 

feature geodatabase, comprised of the video frame outline (polygon), ground track of 

the sensor platform (point) and the center of the video frame (point). 

7. To use this extracted metadata, on the Video Search dialog click the Add frame 

outline feature classes and/or feature datasets button. Navigate into your 

Searchindex.gdb, select all the <filename>_FrameOutline feature classes, then click 

Add. The feature class files will be added to the search index. Click on the Search 

button at the bottom of the window to search the archive and identify video segments 

meeting your search criteria. 

 

4.10.1.2 Refine the Video Search Criteria 

An important capability of the Video Search tool is to refine your search through a collection of 

video files based on geographic location, feature(s) and/or time window. This enables you to 

focus your search to pertinent criteria for more effective analysis. You can filter your search by 

spatial extent, and/or by a selected feature and/or by a specific time range. These filters are 

“nested”, meaning that all the conditions that you specify are applied to filter the search. For 

example, if you specify your search criteria by a selected feature within the extent of your current 

map display and having a specific time stamp range, only the video segments meeting all the 

conditions will be identified and loaded into the search results window. 
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Search by Spatial Extent 

 

You are presented with two options when searching by geographic extent, the extent of your 

current map display, or by drawing a bounding box on the map display. 

The default filter for search criteria is to limit the search by the current map extent of your 

ArcMap display window.  

You may also define the geographic extent of your search by drawing a bounding box on your 

ArcMap map display by clicking on “Limit the search using the Draw Bounding Box tool below”, 

then click on the draw tool   to enable it, and draw a bounding box on the map in your 

ArcMap display. The geographic map coordinates of your bounding box will be displayed. You 

may redraw the bounding box multiple times, only the coordinates of the most recent bounding 

box are retained as your spatial extent. 

 

Search by Selected Features 

 

Filter your search to specific features displayed on the map. Load a feature class into ArcMap 

which is then displayed as a layer in the Table of Contents. Restrict your search to any number of 

features in the ArcMap display by selecting the “Search by selected features using the Select 

Features tool below” check box, then click on the select features tool  to enable it. Click on 

individual features in the map, or select multiple features by depressing the left mouse button 

and select by rectangle. The number of features selected are listed. 
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Search by Time Range 

 

Limit the search by specifying a time range. Select the “Search by time range” check box, then 

specify a start date and time and end date and time for your time range. You may select a date 

from the calendar GUI, or simply type in the date. Increase or decrease the time increments with 

the up or down arrows or simply type the time in 24-hour notation.  

All video segments with time stamps within the specified time range will be identified and loaded 

into the results window. 

 

4.10.1.3 Video Search Results Window 

When your search criteria are specified and search indexes are loaded, click on the Search button 

  at the bottom of the Video Search window to start searching for video segments 

meeting your criteria. The search tool will comb through the collection of videos and identify all 

the video files – and segments within those video files – and display them in the video results 

window. 
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The Results Window lists the video files identified, and identifies all the video segments meeting 

the search criteria. All the segments are listed with their UNIX time stamp, the length of the 

segment, the name of the video and the directory path to the video source file. These results can 

be organized by any of the fields, for example by segment length from longest segment to 

shortest segment. 

The video segments may be loaded into the video player by simply double clicking on any of the 

fields of the video segment you wish to view, by displaying a context menu with a right click and 

selecting Queue Video, or by selecting the video segment of interest and clicking on the Queue 

Video button.  The Video Player will open with the video loaded. Click Play and the video will 

jump to the proper time stamp location within the video and begin playing. 

Click on the Export the selected segment as a new video clip button  to save the segment 

as a new video file defined by the timestamp and segment length. The new video clip may be 

saved in any of the 12 supported video file formats. Video search results may be saved and 

loaded, and individual video segment or all video segments may be deleted from the search 

results window. 

 
Note: Results from subsequent multiple searches will be appended to the existing results 

listed in the Search Results window. 

 

4.11 Video Properties Pages 

To view and configure the properties associated with an individual video, use the video’s 

properties dialog. The capabilities of each page are described in the following section. 



Using the ArcGIS Full Motion Video 1.4 Add-In 

 

Copyright © 1995-2018 Esri. All rights reserved. 39 

Steps: 

1. From the manager, right click on a video and select Properties from the context menu 

to launch the Properties dialog box. The Properties dialog box opens. 

 

4.11.1 Accuracy 

Use the Accuracy tab to enhance to positional accuracy of features and graphics on both the 

video and map using an elevation model. The increased accuracy applies to video digitizing, video 

marking, and displaying features from the map on the video. The dataset must be loaded into 

ArcMap and available in the Table of Contents. The elevation dataset must be a single band 

elevation dataset, such as the Esri elevation image service, DEM or other supported elevation 

dataset. In some cases, using a DEM service may slow down the performance of the video player 

due to slow network or internet connection. 

If you do not have access to a DEM or want optimal performance of the video player, assign a 

constant elevation value. This can improve accuracy, especially in flat or gently rolling topography 

by assigning an average elevation value. 

 

4.11.2 Bookmarks 

The Bookmarks tab shows all of the bookmarks that you have created for this video and allows 

you to manage them. The menu is empty until you add a bookmark to capture a specific 

time/location within the video. A bookmark is added by either clicking the bookmark icon on the 

video player or on the Bookmark Properties dialog while a video is playing or paused. Check the 

Display description in the bookmark menu box to show or hide long descriptions in the 

bookmark menu. Use the Import bookmarks button to import bookmarks from a .csv file or from 
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an .xml file. To clip part of a video using bookmarks, select the bookmarks that represent the 

beginning and end points and click the Select two bookmarks to export a video clip button. 

 

Bookmarks are a very useful way to identify and utilize important information in your video data.  

You can include virtually any amount of information in the Description field which can then be 

searched for key words. Supported key word search include AND and OR Boolean operators. 

 

Note:  You can add a bookmark from the Bookmark button in the video player window, 

from the button in the Bookmarks properties dialog box, and by using the Ctrl + B 

shortcut when the video properties window is in focus. Bookmarks are indicated by tick 

marks on the time-slider of the video player. 

 

The following table describes the functionality of the buttons on the Bookmarks property page. 

 Create new bookmark 

 Delete bookmark 

 Export bookmarks  

 Import bookmarks  

 Clip using bookmarks 

Bookmarks may also be searched by keyword   
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4.11.3 General 

The General tab gives you options for adjusting the duration of each step forward and backward 

increment, in seconds. You may also choose to check the “Check to maintain smooth playback 

for videos with minimal metadata” checkbox. This performs an interpolation between metadata 

packets when displaying video footprint data on the map, rather than abruptly “jumping” to the 

map locations defined in the metadata. 

 

 

4.11.4 Imagery 

The Imagery tab is where you set the properties of video frame images saved to disk. There are 

two sub tabs for setting properties of the two modes of capturing imagery; either as single frames 

or as groups of images. Each mode has specific property setting options for capturing video 

frames.  

 

4.11.4.1 Capture Single Images 

Capture Single Images is invoked when the camera icon button  is pressed on the video 

player. The Camera button captures single digital video frames to disk, either when the video is 

in the pause state, or during video playing an archived video or a live stream video. Several 

popular image formats are included, and georeferencing information is provided in a separate 

.aux.xml file associated with the image file. This allows video frame imagery in all formats to be 

projected and displayed on the map and used in subsequent functions and tools.  
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Video mage frames may be saved in any of the supported image formats including .tif, .jp2, .jpg, 

.ntf and .png 

The saved images are named according to the video name appended by the segment time stamp. 

For example, video image frames saved from a video named Interstate25.ts at a one second 

interval are named Interstate25.4.02.tif, Interstate25.5.02.tif, Interstate25.6.02.tif, etc. The map 

projection information is saved in an associated .aux.xml file which allows all images in all formats 

to be projected onto the map or utilized in subsequent functions and tools such as image 

mosaicking. The .aux.xml files are named the same as the image they are associated with, for 

example, Interstate25.4.02.tif.aux.xml. Other files associated with the image files include a 

geoferencing world file and image overview file, also named appropriately in order to link them 

with their corresponding image file. 

When video frame imagery is projected onto a map, they are stretched and rotated according to 

the map projection specified for the map frame. 

 Note: Files without any metadata are saved as .png and are not added to the map. 

 

Output Directory 

Specify the directory for the captured images to be saved to disk.  

Captured georeferenced imagery may be added to the map as they are saved to disk by checking 

the checkbox.  
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4.11.4.2 Capture Groups of Images 

Capturing groups of images is the workflow where multiple video frames are captured at a 

specified time interval as the video player is playing an archived or live streaming video. These 

groups of images usually have good overlap and are conducive to generating mosaic datasets via 

integrated geoprocessing tools. Since these collections of images are georeferenced and can be 

saved in standard formats they can also be easily imported into other image processing 

environments such as mosaicking and exploitation applications. 

To start capturing digital video frames to disk, go to the Video Manager and click the Capture 

button associated with the video. The Record button turns red to indicate that the record mode 

is active. The video may be a live stream or archived video. Video frames are only captured while 

the video is playing. Capture stops when the video player is in pause or stop modes, or the 

Capture button on the Video Manager is deselected with a click.  

 

When video frame capture is turned on in the Video Manager (see above), the Recording Status 

in the Video Player is turned to red (i.e., active, see below). 

 

The group of video frames are captured in the NITF (.ntf) format together with associated 

metadata in a comma separated values (CSV) file for each image and saved to the specified 

directory. The first step is to set the video frame capture rate. This value determines how often 

NITF files are captured while a video plays. For example, if your video is recorded at 30 frames 

per second and you specify a capture rate of 500 milliseconds, 2 video frames per second will be 

captured to disk. High capture rates resulting in large numbers of digital video frames saved to 

disk may decrease performance of the video player playback.  
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A CSV file containing the metadata for each captured video frame image is also created and saved 

to the same directory. This metadata CSV file is used by the Mosaic Video Frames GP tool or other 

Esri or third party mosaicking or image orthorectification packages. The metadata captured and 

written to the CSV includes the following comprehensive image information with the field 

heading names: 

ImageName, Frame Center Latitude, Frame Center Longitude, Sensor Altitude, Sensor Latitude, 

Sensor Longitude, Platform Heading, Platform Pitch, Platform Roll, Sensor Relative Azimuth, 

Sensor Relative Elevation, Sensor Relative Roll, Precision Time Stamp Esri, Precision Time Stamp, 

Elapsed Video Time, Sensor Horizontal Field Of View, Offset Corner Latitude Point 1, Offset 

Corner Longitude Point 1, Offset Corner Latitude Point 2, Offset Corner Longitude Point 2, Offset 

Corner Latitude Point 3, Offset Corner Longitude Point 3, Offset Corner Latitude Point 4, Offset 

Corner Longitude Point 4, Video Source. 

The output directory of the collection of video frames is specified via the output file browser. If 

no directory is specified, a capture directory is created with the standard ArcGIS default directory 

path and video file name, for example, D:\Documents\ArcGIS\Input_Video_File_Name. 

 

Sometimes NITF's are unable to be georeferenced when capturing a video frame in “Capture 

Groups of Images” mode. This is due to sparsely populated Key Length Values (KLV) while the 

video digitizer seeks higher granularity of metadata. In other words, the metadata is too sparse 

for the video digitizer to find an appropriate metadata value to assign to the video frame. Also, 

sometimes the frame corners simply aren't specified in the metadata for the particular KLV 

payload.  
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After video frames are captured, you can add them to a mosaic dataset straightforwardly by using 

the Full Motion Video Tools > Mosaic Video Frames geoprocessing Tool. The mosaic dataset 

workflow is addressed in the section following this Property Page section. 

 

4.11.5 Metadata 

The Metadata tab controls where you save the platform, frame center and frame outline data 

when recording metadata. You can either use the default feature classes, select an existing 

feature class or create a new one. When recording you have the option to add the layers to the 

map as they are captured. 

 

When capturing metadata, you can change the rate at which data is collected. Think of this as a 

sampling technique. It is recommended that you start with the default and increase the 

frequency if there are gaps between overlapping images. 

 

4.11.6 Symbology 

The Symbology tab allows you to change the symbol color and style for the field of view, frame 

center, and frame outline graphic displayed on the map. You can also change the symbol 

representing the imaging platform and have it point in the heading direction. 
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4.11.7 Time 

The Time tab lets you determine how often to query time-aware layers. Use the Query Forward 

and Query Backward options to create a time window before and after each frame. This is useful 

if you want to see if features occupy the current video frame at a given time.  
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Note:  For each time-aware layer that will be queried, it is important to enable time. 

 Steps: 

1. From the ArcMap table of contents, right-click on a time-aware layer to open 
the Properties dialog. 

2. Click the Time tab. 

3. Check Enable time on this layer 

4. Click the Calculate button to create a valid time step interval. 

 

In the video manager, the Time Query button allows you to query time-aware layers. 

 

Note:  Time querying may require significant resources depending on the number of 

time-aware layers and features. After running a single time query, ArcMap will be left in 

a queried state. At this point it may be necessary to use the Reset Time Extent button 

on the Customize menu of the Video Manager to view the full time extent of all of the 

layers in ArcMap. 

 

4.12 Digitizing Features in the Video Player and Map 

Digitizing features is a more robust workflow that integrates seamlessly with the ArcGIS editing 

tools and feature templates. Whereas marking allows you to create points, digitizing allows you 

to create points, lines, and polygons. When you digitize features you can add values to the 

attribute table of the features. 
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Features digitized in the video are displayed on the map, and features displayed and digitized in 

the map are displayed on the video in a seamless bi-directional manner. 

Load the feature class data into ArcMap and make sure it is displayed. If the video footprint 

coincides with the feature data, it can be displayed in the Video Player as an overlay on the video 

by clicking on the Start displaying features from the map on the video button. The feature data 

will be displayed on the video in play or pause mode, but not in fast forward/backward or step 

forward/backward modes. 

 

 

Note: since feature layers are often created using an orthorectified image as a backdrop, 

any features digitized in the video player using unrectified video imagery will not 

necessarily be precisely registered to the map or feature layer. It is a sketch showing 

where the feature layer needs to be revised using an updated orthoimage backdrop. 

To digitize point, line, polyline or polygon features, open an editing session in ArcMap. Learn 

more about editing features. 

Features are digitized in the video player in pause mode only. If the video is playing when you 

start to digitize a feature, the video will be automatically paused in the player. Only polygon 

feature types can be digitized in the video player. As features are digitized in the player, they will 

be visible in real time on the Map display. Conversely, features may be digitized on the map 

file:///c:/temp/Using_FMV_2014-11-15_16_01_22.647000/output/GUID-0B236129-9DDD-41F6-B9D4-F7EA4C93C302
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display in ArcMap and displayed in the video player. In this case, the feature will be updated and 

visible in the player once the feature digitization on the map is completed. 

Save the new features by saving the feature class data in your editing session. 

 

Note: Sometimes the features class layer in the video player appears to be offset from 

the corresponding feature on the map display. This is expected behavior and is due to 

the high oblique angle and long distance from the sensor and the ground location. At 

certain times the GIS layer features will be well-registered to the ground feature, other 

times not so well. 

 

5.0 Full Motion Video Geoprocessing Tools 

5.1 Introduction 

The FMV geoprocessing tools make it easy to analyze and manage your video data. The tools 

group functionality into simple image and metadata extraction, mosaicking, and video 

multiplexing.  

The FMV toolset contains the following tools:  

• Extract Video Extent – creates a single polygon showing all areas filmed by a video. 

• Extract Metadata from Video – extracts each video frame and metadata packet into a 

feature class. 

• Extract Video Frames for Orthomosaic – prepares video data for orthorectification. 

• Mosaic Video – creates a mosaic dataset from a video. 

• Mosaic Video Frames – creates a mosaic dataset from frames and metadata generated in 

the add-in. 

• Video Multiplexer – creates a new video file from a non-MISB compliant input video and 

metadata set. 

5.2 Using the FMV Geoprocessing Tools 

This section outlines some of the most important FMV geoprocessing guidelines, but does not 

offer step-by-step instructions for each tool. The FMV geoprocessing tools are relatively 

straightforward and run as typical geoprocessing operations.  E.g. enter the required parameters, 
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then start processing. If you need more information about the individual FMV geoprocessing 

tools, detailed help is available for each tool by right-clicking any of them and selecting either 

Help or Item Description. 

5.2.1 Generating Python scripts automatically 

If you want to run batch processing on any of the FMV geoprocessing tools via Python, you can 

first automatically generate a python script by running any of the tools once, right-clicking on the 

tool in the Results window, and selecting Copy as python snippet.  (The Results window can be 

accessed by clicking on the Geoprocessing tab on the main menu in ArcMap and selecting 

Results.)  From here you can just copy and save the script into text or a Python file. To test or run 

the new script simply open the Python window in ArcMap, paste the code, and click Enter to start 

the process.  

 

5.2.1.1 Understanding Important FMV Geoprocessing Parameters 

A few of the geoprocessing tools have common parameters characterized by shared behavior.   

Some important parameters are addressed below. 

Start Time 

This optional value allows the GP tool to process a subset of the full video, defining the start time 

with a value representing a time offset from the beginning of the video.  The input format is 

d.hh:mm:ss and the default start time is 0.00:00:00.  Note that “d” is days, “hh” is hours, “mm” 

is minutes, and “ss” is seconds. This parameter allows you to specify the beginning of the desired 

video segment.  

The geoprocessing tools that utilize start and end time to subset your processing include Extract 

Metadata from Video, Extract Video Extent and Mosaic Video. 

End Time 

This optional value sets the end time for processing in the GP tool. The input format is 

d.hh:mm:ss. Note that “d” is days, “hh” is hours, “mm” is minutes, and “ss” is seconds. If left 

unset, the value will default to the end of the video. This parameter allows you to specify the end 

of the desired video segment processed by the GP tool. 

Video Playback Rate 

This value represents the playback rate of the video during metadata extraction. A value of 1 is 

normal playback speed, 2 is equal to 2x normal speed, and 10 is equal to 10x normal speed. Faster 
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playback rates result in shorter metadata extraction times and potentially less recorded 

metadata. The default is to play at normal speed; however, higher rates, such as 10x, 20x, or 

more, are highly encouraged. The geoprocessing tools that utilize this parameter include Extract 

Metadata from Video and Extract Video Extent. 

Metadata Extraction Rate 

This optional parameter sets the rate of image capture from the video. A value of 1 means that 

an image will be captured once every second. If left unset, the value will default to an interval of 

one video frame captured every two seconds. The minimum capture interval is 0.1 seconds. The 

figure below shows all four of the parameters outlined in this section. 

 

5.2.1.2 Tips on using the Extract Metadata from Video GP tool 

Data management quickly becomes an issue with users who collect video data on a regular basis. 

This tool allows you to quickly extract video metadata and create feature classes that represent 

the platform, frame center, and frame outline. This tool is particularly useful because it can be 

run at high speeds. For example, one of the input variables is called Video Playback Rate. This 

variable allows you to extract data at high speeds, such as 20, 30, 50 or more times the normal 

play rate, thus making it easy to quickly archive large amounts of metadata. Experiment with the 

Video Playback Rate and other variables. Many users use a Video Playback Rate of 50 and a 

Metadata Extraction Rate of 1 with videos that are 30 frames per second. Extremely fast 

playback rates may result in less metadata per video time. 
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5.2.1.3 Using the Extracting Metadata from Video GP Tool in Batch Mode 

Extracting metadata can be a time consuming activity, especially if you collect video data on a 

regular basis. The process can be streamlined by using an ‘Iterator’ within a geoprocessing model 

as shown in the image below. 

New videos are put into the Iterators folder, as shown in the image of the geoprocessing model 

below, and the tool is run.  

The model below is available by installing the FMV add-in, installing the FMV geoprocessing tools, 

opening the Video Search window in the add-in (Video Manager > Search > Video Search Tool…) 

> Use these tools to create search indexes for new videos > Save a toolbox and geoprocessing 

model to index multiplex videos. This new toolbox contains the model below.   

  

5.2.1.4 Creating a mosaic dataset using the Mosaic Video Frames tool 

There are two different ways to create a mosaic dataset from a video.  

1. The Mosaic Video geoprocessing tool, which is straightforward, requires one step, and 

uses an individual archived video file as input. 
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2. The Mosaic Video Frames geoprocessing tool, which requires two steps and uses 

individual NITF images and associated CSV files containing metadata as input. This 

input, of images and metadata, is always previously extracted from the video using 

the FMV add-in’s Capture tool.  

Just like the Mosaic Video tool, the Mosaic Video Frames tool is used to add video frames and 

MISB metadata into a mosaic dataset. The Mosaic Video Frames tool is beneficial because it 

allows the creation of mosaic datasets from real-time video frames and metadata, from either 

archived video files or live streams.    

Instructions for using the Mosaic Video Frames geoprocessing tool: 

Step 1: The first step is to capture groups of video frames in a NITF format to an output directory. 

To do this, open a video > right-click the video > Properties… > Imagery > Capture Groups of 

Images. Set a frame capture rate and an output directory. Next, start capturing frames using the 

Capture button, which you’ll find by going to the Video Manger > finding your video and clicking 

the associated Capture button. Make sure to click Capture again to stop capturing when you 

done. 

Step 2: The next step is to open the Mosaic Video Frames geoprocessing tool and use the images 

and metadata from step 1 as the input parameter for “Input Video Frames and Metadata 

Directory”. Now you’re ready to run the tool and create the mosaic dataset. To explore metadata 

associated with each frame go to the mosaic dataset in ArcMap’s table of contents > right-click 

on Footprint > Open Attribute table. Here you’ll see metadata associated with each frame, 

including sensor location, altitude, time stamp, video path, and more.  

 

Note:  There is a known issue associated with NITF within ArcGIS. As a result, some of 

the captured frames may not be included in the mosaic dataset. This issue only occurs 

with NITF. If an area of the mosaic dataset is needed and is not supported by NITF, any 

of the other image types can be substituted.  

 

5.2.1.5 Extract Video Frames for Orthomosaic Geoprocessing Tool 

The Extract Video Frames for Orthomosaic tool is used to prepare imagery and metadata, derived 

from a video, for use in an orthomosaic. The result is a JPG or TIFF image of each video frame 

with either an EXIF header, or a separate CSV (comma Separated Value) file associated with the 

JPG or TIFF image. The percentage of image overlap applies only to forward overlap along the 

flight line and not overlap between flight lines. It is important to note that the purpose of this 

tool is to produce imagery and metadata suitable for input into either the Esri Ortho Mapping 
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Tools, Drone2Map, or another third party ortho mapping application. It is also important to note 

that the ortho mapping applications require that the imagery is captured at or near nadir (i.e., 

looking vertically downward). 

Important notes about the tool include: 

1. The output from this tool is meant to be used in the creation of orthomosaic dataset, 

in additional software outside of FMV, such as the Esri Ortho Mapping tools or 

Drone2Map.  

2. The supported output image formats include JPG and TIFF. When the EXIF metadata 

type option is selected, the images include EXIF (Exchangeable Image File Format) 

information in the headers.  

 

The metadata associated with each image generated by the tool is either written to a CSV file or 

into each image’s EXIF file header.  

The metadata contained in the CSV file associated with the output images is listed here:  

• Image Name 

• Frame Center Latitude 

• Frame Center Longitude 

• Sensor Altitude 

• Sensor Latitude 

• Sensor Longitude 

• Platform Heading 

• Platform Pitch 

• Platform Roll 

• Sensor Relative Azimuth 

• Sensor Relative Elevation 

• Sensor Relative Roll 

• Precision Time Stamp Esri 

• Precision Time Stamp 

• Elapsed Video Time 

• Sensor Horizontal Field of View 

• Offset Corner Latitude Point 1 

• Offset Corner Longitude Point 1 

• Offset Corner Latitude Point 2 

• Offset Corner Longitude Point 2 

• Offset Corner Latitude Point 3 

• Offset Corner Longitude Point 3 

• Offset Corner Latitude Point 4 

• Offset Corner Longitude Point 4 

• Video Source  
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The metadata contained in each image’s EXIF file header is shown in the following image: 

 

5.2.2 Video Multiplexer 

The Video Multiplexer geoprocessing tool combines non-MISB compliant videos with required 

metadata into new MISB compliant videos for use in the Esri FMV Add-In.  

In this context, the term multiplexing refers to the process that combines a video and its 

associated metadata into a new MISB-compliant video. Only videos that meet the MISB standard 

specifications can be used within the Esri FMV Add-in.  The screenshot below shows the Video 

Multiplexer tool, and the following sections will review the input parameters and detailed 

instructions. You can also refer to the help within the Video Multiplexer geoprocessing tool for 

additional details about each input parameter. 
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5.2.2.1 Video Multiplexer Requirements  

To use the multiplexer, you will need to have a video and an associated metadata file in a 

readable text format.  The video will come from a camera system, and must be in one of the 12 

supported formats (mpg, mp4, ts, etc).   

The metadata will come from appropriate sensors, such as GPS for (x,y,z) position, and IMU 

(inertial measurement unit) or other data sources for camera orientation.  The metadata will 

typically require editing to ensure proper content and formatting, described in more detail 

below.  Following any editing, the metadata must be saved in a CSV (Comma Separated Values) 

format.  This file will be referred to here as ‘metadata.csv’, but note that is not a required 

filename. 

In some cases, if sensors are not available to provide the required metadata, some of the required 

parameters may be estimated – a typical example is sensor orientation.   GPS is typically available 

to specify camera location, but if the camera orientation is not captured by a sensor, it may be 

acceptable (determined by your application) to estimate its orientation (e.g. facing forward, such 

that heading may be estimated from changing GPS positions, and aimed 30 degrees below the 

horizon of the aircraft).   Be aware that the accuracy of your results will depend on the accuracy 

of the data input to the multiplexer.   



Using the ArcGIS Full Motion Video 1.4 Add-In 

 

Copyright © 1995-2018 Esri. All rights reserved. 57 

When complete, your metadata.csv file will look something like this (in this case, viewed in 

Microsoft Excel™): 

 

Continue below for further details. 

 

5.2.2.1.1 Minimum Data Fields 

At a minimum, your metadata.csv file must contain these data fields:   

• UNIX Time Stamp  

• SensorLatitude 

• SensorLongitude 

It is important to note that if you have only this minimal metadata, the location of the sensor will 

be displayed on the map, but the footprint of the video cannot be displayed, and some 

geoprocessing tools will not be able to process the video. 

5.2.2.1.2 Metadata required for displaying a footprint (frame outline) on the map 

One of the major benefits of FMV data is calculation and display of the four corners of the video 

image frame, also called the frame outline. Once you have four corner data you can perform 

many useful activities, such as digitize features on the video and map, measure distance within 

video, extract georeferenced image frames, and more.  

Often videos from drones, fixed mount surveillance cameras, or other sources do not have four 

corner data. The FMV Video Multiplexer can create the four corner data assuming the metadata 

contains the proper information regarding the location and orientation of the sensor, and the 

camera field of view.  

To compute and display the relative corner points of the video frame footprint as a frame outline 

on the map, you will need metadata to populate the 11 fields below. Given complete and 

accurate metadata, the FMV Video Multiplexer will automatically calculate the video frame 

corners, and thus the size, shape and position of the video frame outline which may then be 

displayed on the map. 
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These 11 metadata parameters are defined here.  These field names must be present in the input 

metadata.csv file exactly as shown: 

UNIX Time Stamp: Coordinated Universal Time (UTC) represented as the number of 

microseconds elapsed since midnight (00:00:00), January 1, 1970. Derived from the POSIX IEEE 

1003.1 standard.   Time resolution: 1 microsecond.  Note that a recommended time interval for 

separate metadata records is 1 second 

SensorLatitude: The latitudinal position of the sensor aboard the aircraft, in decimal degrees. 

Based on WGS84 ellipsoid. 

SensorLongitude: The longitudinal position of the sensor aboard the aircraft, in decimal degrees. 

Based on WGS84 ellipsoid. 

SensorAltitude:  Although the MISB specification defines sensor altitude as the altitude of the 

sensor Above Mean Sea Level (AMSL – also known as orthometric height), the current version of 

the multiplexer does not allow input of a Digital Elevation Model (DEM), so adjustment for 

variable height above ground are not supported.  As a result, input of SensorAltitude into the 

multiplexer must represent height above ground in meters.  See below for alternative workflows 

for calculating these values. 

PlatformHeading: Aircraft heading angle. Measured from forward longitudinal axis relative to 

True North measured in the horizontal plane, positive clockwise. (0…360, where “due East” 

would be 90) 

PlatformPitch: Aircraft pitch angle determined by the rotation around the side-to-side axis of the 

collection platform, also described as nose up or nose down, measured positive upward. 

(0…+/- 20).  Note that Pitch = 0 means the platform is aimed toward the forward horizon, so for 

a sensor aimed at nadir (straight down), the SensorRelativeElevation would typically be 

approximately -90. 

PlatformRoll: Aircraft roll angle determined by the rotation around the longitudinal axis of the 

collection platform, measured positive clockwise when viewed from behind.  0 means level flight, 

+10 degrees means airplane right wing is lower than left wing.    
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(Graphic courtesy of http://www.gwg.nga.mil/misb) 

HorizontalFOV: Horizontal field of view of the imaging sensor and lens expressed in degrees 

(0…180).  

SensorRelativeAzimuth: Relative rotation angle of sensor orientation to platform longitudinal 

axis, expressed in degrees (0…359.99). Measured positive clockwise as seen from above. 

SensorRelativeElevation: The Relative Elevation Angle of the sensor specifies the sensor 

orientation relative to the platform transverse-longitudinal plane, measured in degrees positive 

upward.  A camera aimed toward the direction of flight would show SensorRelativeElevation = 0, 

whereas a camera aimed out of the floor of the aircraft would show -90. Positive angles would 

represent viewing above the horizon.  

SensorRelativeRoll: Relative roll angle of the sensor relative to the aircraft platform. Rotational 

angle of the camera about the lens axis. Top of image is zero degrees. Positive angles are 

clockwise when looking from behind the camera.  Angles are expressed in degrees (0…359.99). 

http://www.gwg.nga.mil/misb
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The graphic above left serves to describe the relative sensor orientation while the graphic on the 

right illustrates the how the video corners are projected onto a map. Graphic courtesy of 

http://www.gwg.nga.mil/misb 

The 11 parameters above comprise the minimum metadata required to compute the map 

transform between the video and the map, display the video footprint on the map, and enable 

other functionality, such as digitizing, marking, and measuring on the video. 

5.2.2.1.3 Fully MISB-Compliant Video 

The full MISB specification defines 93 parameters. If all these parameters are available in your 

metadata file they will be encoded into the final MISB-Compliant video for FMV. While all these 

parameters are available in the MISB-compliant video, they are not used to compute the video 

footprint. If the four corner data is already available in the metadata, it is not necessary to 

compute the four corner data and will simply be encoded in the final MISB-compliant video. See 

http://www.gwg.nga.mil/misb/zip_pubs.html for the MISB specification. 

 

5.2.3 Workflow to Generate MISB-Compliant Video 

The workflow and tips to generate MISB-compliant video data for use in the FMV Add-In are 

described below. 

5.2.3.1 Process the video (if necessary) to remove optical distortion 

Video data from consumer drones, surveillance cameras, mobile cameras, etc. may be collected 

with a very wide field of view, referred to as a “fisheye” lens.  This creates wide panoramic images 

with a characteristic curved appearance and introduces significant visual distortion. This 

distortion should be removed prior to running the multiplexer to correct the video data and 

http://www.gwg.nga.mil/misb/zip_pubs.html
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produce images with straight lines of perspective. The corrected rectilinear images are needed 

to compute the most accurate map transform and four corner data. 

Programs to remove fisheye distortion are often included as an application on the drone, or 

independent fisheye correction applications can be applied. Refer to the instructions for your 

camera to remove fisheye distortion from video data before input into the Video Multiplexer 

geoprocessing tool.  

5.2.3.2 Format the Metadata CSV file 

The FMV multiplexer will generate a MISB compliant video file based on an input video file and 

metadata file in CSV format if the input metadata file is properly formatted.  It is presumed you 

are beginning with metadata in a TXT, CSV, or XML format that can be imported into a 

spreadsheet application such as Microsoft Excel™ to generate a metadata.csv file.   (Note: in this 

document, we are referring to “metadata.csv”, but this is not a required filename). 

It is recommended to fully populate your CSV file with all fields listed above in section 5.2.2.1.2.  

If the minimum metadata is not available, you may choose to estimate the missing values (e.g. 

for sensor orientation, sensor FOV, etc.).   

It is also recommended that the first row in your CSV file includes the exact headings listed in 

section 5.2.2.1.2, but note that if you have an alternative format for your data, it is possible to 

cross reference your existing fieldnames for compatibility with the multiplexer by using a field 

mapping template (see section 5.2.3.3 below).   

The remainder of this section reviews some key metadata fields with advice to ensure proper 

formatting in the metadata.csv file that you input to the multiplexer. 

5.2.3.2.1 Timestamps  

Timestamp data is often in human readable form such as date, hours, minutes and seconds. This 

must be converted to standard UNIX time format for input to the multiplexer.   

If you have a metadata file for your video with irregular time intervals between records, you will 

need to build a calculation to convert your current time format to UNIX time format.  As noted 

above, this is represented as the number of microseconds elapsed since midnight (00:00:00), 

January 1, 1970.    

If your metadata has a consistent time interval between records, it may be simpler to calculate 

the start and end times in UNIX format and then increment each record.  You can use a website 

such as http://www.epochconverter.com/ to do the initial conversion from readable time to 

Epoch (UNIX) time.  

http://www.epochconverter.com/
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 Steps: 

• Enter the timestamp for the first record value from your metadata file into the Epoch 

time converter. You may have to adjust for your local time which will be offset from 

Greenwich Mean Time, so when you enter the date and time values into the 

converter, add the proper number of hours from Greenwich Mean Time. 

• http://www.epochconverter.com/  gives the time in milliseconds, whereas the MISB 

standard requires time in microseconds, so you will need to multiply by 1000.  Enter 

this value into a new field (column) in the spreadsheet with the field heading name 

“UNIX Time Stamp”. Your time stamp will have 16 digits, e.g. “1421690042746000”. 

• Do the same for the timestamp in your last record 

• Open your metadata file in a spreadsheet (instructions here for Microsoft Excel™) and 

create a new column for intermediate timestamp calculations.  Enter the first and last 

UNIX timestamp values for the video in the corresponding records. 

• Subtract the first record timestamp value from the last timestamp to derive the total 

length of time of the video in Epoch UNIX time.  As a QC step, divide by 1,000,000 to 

get the video length in seconds, and verify if this matches your video duration. 

• Divide the total duration of the video above by the number of data records to get the 

average time span between records. 

• In your column for intermediate timestamp calculations, add the average time span 

to the UNIX timestamp value in the previous record and copy down to yield the 

estimated timestamp for each record.  

• Create a new column for your final timestamp values, and enter the label “UNIX Time 

Stamp” in the first row.  Copy all values from intermediate timestamp column and 

“paste special/paste values” to ensure all records have simple numbers in this 

column, not equations. 

• Ensure the “UNIX Time Stamp” column in the spreadsheet is formatted as “Number” 

with zero decimal places.    

• Verify that the last record in the “UNIX Time Stamp” column is the same or very close 

to the value that you expect. 

• Save the file as *.csv format. 

 

http://www.epochconverter.com/g
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Note: Any time you open the metadata csv in Microsoft Excel™, make sure you select 

the UNIX Time Stamp column and format it as a Number, with zero decimal places. This 

is necessary because Excel will, by default, convert these values to scientific notation, 

whereas the Video Multiplexer needs the data as numeric values. 

In addition, be certain to CLOSE the *.csv file before running the multiplexer.  If the file 

is still open, the multiplexer will not operate properly. 

 

5.2.3.2.2 Horizontal and Vertical Field of View (FOV) 

The Horizontal and Vertical FOV must be recorded for each record in the metadata CSV file used 

as input to the multiplexer, in columns labeled “HorizontalFOV” and “VerticalFOV”. 

Note that if your imaging system has a dynamic zoom lens that may change from time to time in 

the video, this must be recorded within your metadata stream for the multiplexer to properly 

calculate the footprint – or alternatively, you must fly your missions without changing the zoom 

lens.   

If your camera has a fixed focal length, you can simply enter the same values for HorizontalFOV 

and VerticalFOV in every record of your metadata CSV file.   

Please refer to the specification of your sensor to determine the proper field of view for your 

sensor. For example, refer to the FOV specification for a GoPro Hero 4 camera is here: 

https://gopro.com/help/articles/Question_Answer/HERO4-Field-of-View-FOV-Information. 

Alternatively, if your camera FOV cannot be found in your documentation, it can be calculated 

using these equations: 

HorizontalFOV = 2*arctan(H_SensorSize/2*f) 

VerticalFOV = 2*arctan(V_SensorSize/2*f) 

where H_SensorSize = horizontal sensor size, V_SensorSize = vertical sensor size, and f = lens focal 

length.  Note each of these values must be in the same units, typically mm.  Be sure to calculate 

& record the field of view values in degrees, not radians. 

5.2.3.2.3 SensorAltitude 

One key feature of the multiplexer is to calculate the size and location of the video footprint, 

based on the camera FOV, height above ground, and camera orientation.  Although the MISB 

specification defines sensor altitude as Above Mean Sea Level (AMSL), the current version of the 

https://gopro.com/help/articles/Question_Answer/HERO4-Field-of-View-FOV-Information
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multiplexer does not allow input of a Digital Elevation Model (DEM).  This means that height 

above ground cannot be calculated by the multiplexer. 

If the terrain of your project area has minimal variability (see below), you can proceed directly to 

the multiplexer using the methods listed in the table below.  Note that the first entry in the table 

refers to many drone-based imaging systems which do not report Z (altitude) values directly from 

GPS, but instead report height values relative to the drone launch point. 

  For a project area with relatively flat terrain 
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Write the reported flight altitude (above launch point) into  
the metadata.csv file for input to multiplexer, and  

enter ZERO for "Average Elevation" 

above mean sea 
level (AMSL) 

Write the flight altitude (above mean sea level, AMSL) into the 
metadata.csv file for input to multiplexer, and enter your 

average project elevation for "Average Elevation" 

The definition for “minimal” terrain variability must be evaluated by your organization, but for a 

general rule of thumb, it is suggested that terrain variation (maximum to minimum) of less than 

20% of your flight altitude above ground can be considered “relatively flat” for this discussion.  

With variation in sensor-to-ground height of 20%, the X size of your video footprint will vary 20%.   

If your project terrain variability is greater than the threshold you choose for the accuracy of your 

video footprint size, proceed to the workflows below to modify the value for SensorAltitude 

written into the metadata.csv file.  Calculation of an accurate footprint requires that the 

SensorAltitude must represent height above ground in meters.  Calculation of height above 

ground, in turn, requires adjusting each sensor altitude value from your metadata using elevation 

samples from a DEM, described in detail in section 5.2.3.2.4. 

  For a project area with variable terrain 
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Using a spreadsheet, add the altitude of your launch point to the 
reported flight altitude for every record to yield sensor height above 
mean sea level (AMSL), then subtract a ground elevation sample for 

that location from a DEM (as described in section 5.2.3.2.4) and 
write this modified value as "SensorAltitude" into your metadata.csv 

file.  Enter ZERO for "Average Elevation" in the multiplexer. 
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above mean sea 
level (AMSL) 

Using a spreadsheet, write the flight altitude AMSL for every record, 
subtract a ground elevation sample for that location from a DEM (as 

described in section 5.2.3.2.4), and write this modified value as 
"SensorAltitude" into your metadata.csv file.  Enter ZERO for 

"Average Elevation" in the multiplexer. 

5.2.3.2.4 Sampling discrete point values from a DEM  

This section provides detailed instructions for accessing a DEM of your project area, and then 

extracting elevation values from the DEM along the path of your video.  These DEM values will 

then be used in your spreadsheet to calculate the sensor height above ground along your flight 

path (as highlighted in the table “For a project area with variable terrain” in section 5.2.3.2.3). 

• Load a basemap from ArcGIS Online that will enable you to identify your entire project 

area.  The basemap is loaded as a layer in the Table of Contents.  Make sure the basemap 

is visible by turning off the Terrain layer in the Table of Contents. 

• Zoom out on the basemap until your whole project area is visible.  This will define a coarse 

area of interest for exporting a DEM. 

• On the main menu in ArcMap choose Window => Image Analysis Window and dock the 

window.   

• Use ArcMap to load the World Terrain service layer from ArcGIS Online.  (Note that ArcGIS 

Pro can also be used to perform these steps – this example simply uses ArcMap).  Click on 

the Add Data icon on the main toolbar.  Select “Add data from ArcGIS Online” and search 

for the “Terrain” elevation service.   Choose the multi-resolution Terrain service, and load 

it as a layer so that it appears in the Table of Contents. 

   

• If the Terrain layer is all black, you can select “DRA” (dynamic range adjustment) 

in the Image Analysis Window to enable an automatic histogram stretch to make the 

terrain more visible, but note this is only to aid visualization.  Select the Terrain layer in 

the Image Analysis Window to make it active. 

• Choose the Clip tool  in the Image Analysis window under Processing.  This clips out 

the section of the elevation data for your current map extent, and loads it as a layer in 

the Table of Contents, named Clip_Terrain.   

• Right click on the Clip_Terrain layer in the Table of Contents and choose Data => Export 

Data.  This opens the Export Raster Data window. 
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• In the Export Raster Data window, select Data Frame (Current) as the extent and 

Dataframe (Current) as the Spatial Reference.  Delete the value in the NoData as: field 

(leave it blank).     

 

• For cell size, enter a suitable value to balance the exported file size with DEM resolution.  

In the USA, based on USGS 1/3 arcsecond DEM source data, a value of 10.3 meters is 

recommended. 

• Verify the Pixel Depth is 32 bit. 

• Navigate to the output directory where you want the elevation data written, give it a file 

name (e.g. ProjectTerrain.tif) and select TIFF as the file format (Format drop down).  

Choose LZW or “none” for compression. 

• Select Save; the elevation data will be written as a .tif file.  Select “Yes” when asked if the 

exported data should be loaded to the Map as a layer. 

• From Catalog, make a copy of your metadata.csv file, and drop the copied metadata.txt 

file into ArcMap display.  It will appear in the Table of Contents.  Right click on the 

metadata.txt file in the Table of Contents and select Display XY Data.  This opens the 

Display XY Data window. 
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• For the X Field, click the drop down arrow and choose Sensor Longitude.  For the Y Field, 

choose Sensor Latitude. 

• In the Display XY Data window, under Coordinate System of the Input Coordinates click 

Edit and choose WGS 1984 as the coordinate system.  If WGS 1984 is not displayed as an 

option, expand Geographic Coordinate Systems > World > WGS 1984 at the bottom of the 

picklist.  Click OK.  This gives a warning that the Table Does Not Have Object-ID Field.  Click 

OK to make the warning disappear.   

• This loads a point feature class layer in the Table of Contents and displays the sensor 

ground track position for each metadata record. 

• Right click on the ground track point data and choose Data => Export Data which opens 

the Export Data window.  Navigate to an output directory and type a file name such as 

groundtrack.shp and be sure to include a .shp extension.  Choose yes when asked if the 

layer should be loaded into ArcMap. 

• Open the "Extract Values to Points" GP tool (Spatial Analyst => Extract => Extract Values 

to Points) and extract the Terrain DEM values.  The Input point features are the 

groundtrack.shp shapefile from the previous step, and the Input Raster is the 

ProjectTerrain.tif file exported above; give the result a new shapefile name such as 

DEMSamples.shp.   

• This new shapefile will now contain elevation samples from the DEM corresponding to all 

of the (x,y) points in your video metadata.  These DEM samples may be used in the next 
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section to convert sensor height metadata into height above ground level for input to the 

multiplexer.  

 

5.2.3.2.5 Processing flight altitude & DEM to yield height above ground level (AGL) 

This section provides detailed instructions using DEM samples to convert sensor height (either 

AMSL or relative to launch point) to height above ground along your flight path (as highlighted in 

the table “For a project area with variable terrain” in section 5.2.3.2.3). 

• Open your metadata.csv in Microsoft Excel™ (or another suitable application), and save 

it with a new name such as metadata_Convert2AGL.csv.  Verify that that the process does 

not truncate the column names.  If so, make sure they are spelled correctly. 

• In the spreadsheet editor, insert two new columns next to the SensorAltitude column.  

As shown in this screenshot, the new columns are G & H.  Copy the name SensorAltitude 

into the header row for column H, and rename the original SensorAltitude column to 

SensorAltitude_ORIGINAL 

 

• Again using the spreadsheet editor, navigate to the storage location for DEMSamples.shp 

and open its DBF file (DEMSamples.dbf). Scroll right until you see the field named 

“RASTERVALU”.  Select and copy all values in this column and return to 

metadata_Convert2AGL.csv and paste the values into column G.  Rename the column 

from RASTERVALU to DEMSamples 
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• Finally, in the new SensorAltitude column, enter an equation to calculate height above 

ground based on the proper choice from the table “For a project area with variable 

terrain” in section 5.2.3.2.3): 

 

o If the values in SensorAltitude_ORIGINAL are relative to the altitude of your 

launch point, calculate the adjusted SensorAltitude as:  

 

where altitude_of_launch is a fixed value, sampled from the World Elevation Terrain. 

 

o If the values in SensorAltitude_ORIGINAL are orthometric height (AMSL) from 

GPS, calculate the adjusted SensorAltitude as:  

 

 

• Save your work by saving the file as an *.xlsx format spreadsheet.  Then Save As CSV again, 

and since CSV files cannot save equations, the SensorAltitude column must contain only 

values.  Select Column H, Copy, and then Paste as Values.   

• Delete the columns for SensorAltitude_ORIGINAL and DEMSamples, and double check 

that the UNIX Time Stamp values are still shown as format=number with zero decimal 

places, not scientific notation.   

• Save the CSV file, and input this into the multiplexer, entering “0” for “average elevation”. 

 

SensorAltitude = (SensorAltitude_ORIGINAL + altitude_of_launch)  – DEMSamples  

SensorAltitude = SensorAltitude_ORIGINAL – DEMSamples 
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5.2.3.3 Field Mapping Templates 

If your field names don’t match the MISB specification you will need to map them with the Field 

Mapping Template. The multiplexer works by looking for field names in your metadata that 

match the field names in the MISB specification. Many times the multiplexer will auto-recognize 

field names; however, you may need to match them using the field mapping CSV.  

The multiplexing field mapping and time shift templates are available after the Geoprocessing 

tools are installed. Go to your install directory and look for a folder called Video Multiplexer 

Templates. A typical location is  

C:\Program Files (x86)\ArcGIS 10.6 Full Motion Video Geoprocessing 

Tools\VideoMultiplexerTemplates.  

The files are titled: Video_Multiplexer_MISB_Field_Mapping_Template.csv and 

Video_Multiplexer_TimeShift_Template.csv.” 

 

Use the Video_Multiplexer_MISB_Field_Mapping_Template.csv to cross reference your heading 

names with the MISB field names. 

 

5.2.3.4 Time Shifts 

Ideally the video images and the metadata are time-synchronous. When this is the case the image 

footprint in FMV surrounds features that can be seen in the video image. However, sometimes 

there is a mismatch between the timing of the video and the timing in the metadata. This leads 

to an apparent time delay between when a ground feature is surrounded by the image footprint 

and when that ground feature is visible in the video image. If this time shift is observable and 

consistent, the multiplexer can adjust the timing of the metadata to match the video. The time 

shifts are applied by creating and inputting an optional CSV file into the Multiplexer, 

FMV_Time_Shift_Template.csv, containing columns labeled elapsed time and time shift in the 

first row, and one or more data rows (one row per time shift; if your data has several points 

exhibiting a time shift relative to your metadata, multiple data rows can apply time shifts at 

different points in the video as necessary).   
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Example 1: The video image seems to lag the FMV image footprint by 5 seconds. This can be 

noticed near the beginning of the video and also near the end. The observation file would contain 

one line:  

0:00, -5  

The entire video is shifted 5 seconds. 

Example 2: There is a 5 second lag at 0:18 into the video and a 9 second lag at 2:21 into the video. 

The time observation file would contain two lines. 

0:18, -5  

2:21, -9 

In this case the video is shifted differently at the beginning and end. 

This is an example of what your Time Shift Observations File (FMV_Time_Shift_Template.csv) 

might look like. 

elapsed time time shift 

0:18 -5 

2:21 -9 

 

6.0 Summary 

The Esri FMV 1.4 Add-In User’s Manual addressed many aspects of the software, including new 

features, installation instructions for the Add-In and the associated geoprocessing tools, and 

details on how to use the three main components; the video player, video manager and the 

geoprocessing tools.  

For more information about Esri’s Full Motion Video Add-In, please visit the FMV Product Page 

at www.esri.com/fmv.  

http://www.esri.com/fmv

